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Introduction 
We would like to issue a special word of thanks to Marla Roll and the Assistive 
Technology Resource Center (ATRC) at Colorado State University for 
providing the resources for this guide. For further details on other components 
of 508 compliance visit the ATRC website (https://accessibility.colostate.edu/). 
Some the content below also comes from Minnesota’s IT Services, Office of 
Accessibility.  

As state programs, we need to ensure the content we create is universally 
usable, including to those who rely on assistive technology in their daily lives. 
By following best practices for creating accessible documents, we ensure that 
content is usable, versatile, and legally compliant. Accessible content is good 
for everyone: 

 Items load better and faster on mobile devices.  

 Captioning allows people to watch video without disturbing anyone else.  

 Navigating content without a mouse may be easier.  

 Printing in black and white helps those who are colorblind or overly 
sensitive to color and also saves money. 

The purpose of this guide is to demystify 508 compliance and help you think 
through how to structure your document from the beginning to help ensure it 
will achieve 508 compliance. This guide condenses the best practices in 508 
compliance as it relates to the documents and processes you as a state Brain 
Injury Program primarily use: Word, PowerPoint, and PDF.  

There is a range of what accessibility means. The Administration for 
Community Living (ACL) expects that grant recipients strive to be proficient in 
meeting 508 compliance. A checklist is provided at the end of each section to 
help you meet the proficient level. Consider each item in the checklist in order 
to meet this level of compliance. 

A common term you might encounter while reading 508 compliance 
information is Web Content Accessibility Guidelines (WCAG); these guidelines 
explain how to make content more accessible to people with disabilities. 
WCAG covers websites, applications, and other digital content, including 
electronic documents. It is developed by the World Wide Web Consortium 
(W3C) Web Accessibility Initiative (WAI). WCAG 2 is an international standard, 
and the 508 standards are closely tied to the WCAG 2 success criteria and 

https://accessibility.colostate.edu/
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requirements (Level A and Level AA). Therefore, you will encounter WCAG 2 
criteria and requirements as you conduct your own review of 508 compliance 
materials and content. 

There are many excellent resources available to you as you learn to make 
documents 508 compliant. However, this too can be overwhelming. The 
secondary objective of this guide is to condense the best practices resources 
so that you have one convenient source for information.  

You will find a section for each of the aforementioned document types to make 
it easier for you to go directly to each section for the type of document that you 
are focused on making 508 compliant. 
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Making Word Documents 
508 Compliant 
Best Practice Overview 

 Use document styles - Use heading and paragraph styles to structure 
the document.  

 Add alt text to images and objects - This includes pictures, clip art, 
charts, shapes, SmartArt graphics, and embedded objects.  

 Use short titles in headings - Keep headings short (fewer than 20 words 
or one line long). This makes it easy for readers to quickly navigate 
your document.  

 Name your hyperlinks appropriately - Your link should contain 
meaningful text that reflects the link destination or subject, rather than 
simply saying “click here.”  

 Use simple table structure - Avoid using nested tables, merged or split 
cells, or blank cells for formatting. 

 Set column header rows in tables - Clear column headings provide 
context and assist navigation of the table contents. 

 Avoid using repeated blank characters - Extra spaces, tabs and empty 
paragraphs can cause people using screen readers to repeatedly hear 
the word “blank.” Instead, use styles with formatting and indenting to 
create white space.  

 Avoid using floating objects - Place objects in line with text for easy 
navigation.  

 Avoid watermarks - Watermarks and other background images may be 
hidden or confusing to people with vision or cognitive disabilities. 
Instead of using a watermark to identify a document as a “draft” or 
“confidential,” include the text in the document title or heading.  

 Fill in document properties - In advanced document properties, enter 
title, subject, and author. 

 Use the Accessibility Checker - This built-in tool will tell you about some 
possible accessibility issues in your document and give suggestions on 
how to correct them. 



 

4 

Best Practice Instructions 
When ensuring accessibility of a Word document the following should be 
considered:  

 Headings 

 Descriptive links 

 Tables and header rows 

 Images and alt text 

 Color contrast 

Below are strategies for how to ensure each of these are 508 compliant. 

Headings 
Headings are used to create an outline, or table of contents, that structures 
your document and helps users navigate the content more efficiently. You can 
apply the concept of headings in almost every kind of electronic content, 
including Word documents and websites.  

 Use headings to provide a page structure or outline, breaking down 
content into manageable subsections. 

 Do not skip heading levels; for example, don’t go from a Level 2 to a 
Level 4 heading without a Level 3 heading. 

 Use headings to indicate sections of content.  

Using “Styles” in Word 
Styles controls the appearance of text (size, color, spacing, etc.) and embed 
the structure of the document such as headings (levels 1-9) and lists (bulleted 
and numbered).  

Word comes with a lot of built-in styles, which are preformatted in appearance 
yet fully customizable. You can also add new styles of your own. It is important 
to realize that the appearance of a style can be modified without changing its 
structural meaning. For example, the style “Heading 2” can be modified to 
appear in any size, font, and color without altering its meaning as a second-
level page heading. That said, it’s important to stick with basic design 
principles for showing the relationships of headings (e.g., first level headings 
should be larger and bolder than subsequent headings). 
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In a long document, Styles help you maintain consistent visual and structural 
formatting. Change the characteristics of the Style and everything to which 
that style has been applied will instantly be updated.  

The structural aspect of Styles has additional benefits. For example, once you 
have applied heading styles to the text, Word’s Navigation pane will display a 
hierarchical outline that lets you jump from heading to heading. Word can also 
use the headings to create a table of contents, complete with page numbers 
that update dynamically as you edit the document. That way, readers can 
easily move from section to section and be able to follow the document’s flow. 

How to use the Styles Toolbar: 

Select the heading level using the Styles toolbar on the Home Ribbon. 

 

You can quickly change the visual appearance of headings across an entire 
document to match your formatting preferences. 

 Set the font, color, spacing, etc., to what you would like Heading 1 to 
be. 

 Highlight the correctly formatted text. 

 Right-click on Heading 1 in the Ribbon and click Update Heading 1 to 
Match Selection. 

Now each Heading 1 will use your preferred formatting. You should see that all 
Heading 1 text has changed throughout your document. (You can also 
click Modify for more formatting options.) 
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Check the Table of Contents 

 To see the Table of Contents that is generated by the headings, click 
on the View Ribbon, then check the Navigation Pane checkbox. 

 The document outline appears on the left side of the document in the 
Navigation Pane. 

 Click on any of the headings in the Navigation Pane to go to that 
section. 

 You can also drag headings in the navigation pane to quickly reorder 
content. 

 

For more details on how to use headings, please visit the page Accessibility by 
Design, Word Documents, Headings (https://accessibility.colostate.edu/ud-
word-docs/#1499875762827-ee92fc3a-ed25) on the Colorado State University 
website. 

Descriptive Links 
When including links out to webpages in a Word document, such as the one 
above, the link should be descriptive. Stay away from naming hyperlinks as 
“click here” or “here” as these do not allow a screen reader to let the user 
know what the link is.  

To make a hyperlink descriptive use the following: 

To format links in Microsoft Office, Select the link text. On the Insert Ribbon, 
click Hyperlink. 

https://accessibility.colostate.edu/ud-word-docs/#1499875762827-ee92fc3a-ed25
https://accessibility.colostate.edu/ud-word-docs/#1499875762827-ee92fc3a-ed25
https://accessibility.colostate.edu/ud-word-docs/#1499875762827-ee92fc3a-ed25
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Type the text that will be displayed in your document in the Text to Display 
field. 

 This should be a description followed by the link in 
parentheses: Description (Link) 

 For example: Accessibility By Design Website 
(http:/accessibility.colostate.edu) 

 This formatting allows for links to be readable in both electronic and 
paper copy 

Type the actual link in the Address field. This is the link that will be followed. 

 

Tables and Header Rows  
While many authors try to indicate a header row by changing its appearance 
(e.g., font and background color), a change of this type provides little or no 
information about the structure of the table. A document that relies entirely on 
visual formatting will, when converted to HTML or PDF, lack the structural 
information needed by readers who use assistive technology.  

Fortunately, Word offers a setting for table headers that provides this 
important structural information.  

To define the header row on a table in Word, right-click on the top row of the 
table and select Table Properties. 

https://accessibility.colostate.edu/
https://accessibility.colostate.edu/
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Next, select the Row tab, and click on “repeat as header” so that each page 
shows the same information at the top of the table:  

 

Images and Alternative Text 
Images can be used to convey information quickly and powerfully—assuming 
they can be seen and understood. However, some readers may not 
understand the meaning of the image; others may not be able to see it due to 
visual impairment, personal viewing preferences (especially on the web), or 
technological limitations. 

Alternate text (“alt text” or “alt tag”) is added to an image to provide a textual 
alternative to visual information. Why is this important? Remember, some 
users will not see your information; instead, they will hear it using text-to-
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speech or screen-reading software. By adding an alt text to an image, you 
make its meaning available to people who, for whatever reason, cannot see it. 

Alternate text should be added to all non-text elements, including: 

 Pictures 

 Graphs 

 Charts 

 Tables 

 Microsoft Office SmartArt 

Make alternate text meaningful to a listener: 

1. What is the context of the image? What meaning does it add to the 
page? 

2. Be concise. Describe only what you expect visual users to get out of the 
image. 

3. If the image is already described in the surrounding text, the alt text can 
be very short. 

4. Avoid redundant statements like “Image of” or “This is a picture of.” 
Simply state the contents. 

5. If an image is purely decorative, mark it as such (methods are 
described on the following pages). 
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How to use alternate text: Office 365 

Right-click on the image, then select Edit Alt Text from the menu. 

 
An alt text panel will open in the document pane to the right. Type a short 
description in the text box. 

 

If the image is decorative, you can check the Mark as Decorative checkbox 
instead. You should only use this option if no meaning will be lost to any 
audience who cannot see the image. (Note, older versions of Word do not 
have the “Mark as decorative” checkbox; there are other methods depending 
on the version you use.) 
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How to use alternate text: Office 2013 – 2016 

Note: Sometimes images that are downloaded from the web have “junk” 
alternate text (usually a long file name). Make sure to manually check every 
image. 

Right-click on the image, then select Format Picture from the menu. (This 
menu option may be Format Shape on other types of graphics). 
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A Format Picture menu will open in the document pane to the right. Select 
the Layout and Properties tab, the third option in the Format Picture Pane. 

 

If it is not expanded already, open the Alt Text menu by clicking on the arrow. 

Type the alt text in the Description box. Ignore the Title field since it will not 
be read by a screen reader. 
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How to use alternate text: Office 2010 & Earlier 

Right-click on the image to get the "Format Picture" menu option. 

 

Click on the "Alt Text" menu on the bottom left. 

The text goes in the "Description" section on the right (not the "Title" section). 
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Color Contrast 
The term “color contrast” describes the difference between text and the 
background. Low contrast affects readers with low vision and color blindness 
(https://nei.nih.gov/health/color_blindness/facts_about). Bright colors and 
patterns can adversely impact someone with traumatic brain injury and their 
ability to focus or read content with bright colors or patterns. 

Tips for Color Use 

 Choose a color scheme that provides high contrast between the text 
and the background. If you have a dark background, the text should be 
light, and vice versa. (Black and white provide maximum contrast.) 

 Avoid the following color combinations: 

• Green and gold  
• Green and red (or related colors) 
• Blue and yellow (or related colors) 

 Use larger text and simple (not ornate) fonts. Sans serif fonts are 
preferable. 

 Use a contrast checking tool. We recommend the Colour Contrast 
Analyser by the Paciello Group 
(https://developer.paciellogroup.com/resources/contrastanalyser/). 

 Don’t rely on color as the sole means of conveying information. For 
example, don’t use color as your only method of indicating heading 
levels. 

 Text can be difficult to read on photographic or gradient backgrounds. 
Set text against a solid background when possible. 

For more instruction on color contrast visit the page Information on color 
contrast (https://accessibility.colostate.edu/color-contrast/#1513890905436-
b2ca1a2f-ec53) on the Colorado State University website. 

Following these steps will help ensure your document is accessible. In 
addition, Microsoft Office has a built-in tool that generates a report on the 
accessibility of a document. The tool is available in both Word and 
PowerPoint. For more information on the Accessibility checker please visit the 
page Information on Accessibility Checker 
(https://accessibility.colostate.edu/ud-word-docs/#1499876534462-3ca463a5-
2e04) on the Colorado State University website. 

https://nei.nih.gov/health/color_blindness/facts_about
https://nei.nih.gov/health/color_blindness/facts_about
https://developer.paciellogroup.com/resources/contrastanalyser/
https://developer.paciellogroup.com/resources/contrastanalyser/
https://developer.paciellogroup.com/resources/contrastanalyser/
https://accessibility.colostate.edu/color-contrast/#1513890905436-b2ca1a2f-ec53
https://accessibility.colostate.edu/color-contrast/#1513890905436-b2ca1a2f-ec53
https://accessibility.colostate.edu/color-contrast/#1513890905436-b2ca1a2f-ec53
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Word Document Accessibility Checklist 
� includes headings and styles 
� uses formatted lists  
� links are descriptive  
� uses designated header rows for tables  
� provides alternative tests for images, charts, graphs 
� has good color contrast 
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Making PowerPoints 508 
Compliant 
PowerPoint is a widely used tool. However, for audience members with 
disabilities, especially those with blindness or vision impairments, or 
individuals with cognitive challenges (learning disability, traumatic brain injury, 
etc.), PowerPoint can present several barriers that presenters need to keep in 
mind when creating presentations. 

A universally designed PowerPoint presentation takes into account the various 
needs of your audience members, whether they are viewing the presentation 
on a laptop, a projector screen or a printed handout, or listening to it with text-
to-speech software or a screen reader. The following pointers will help you 
create presentations that are beneficial to everyone. 

Best Practice Overview  
 Add alternative text to all images and objects.  

 Use clear, concise terms. 

 Use simple tables - These are easier for all to read, including people 
using screen readers and people sitting at the back of the room at a 
presentation. Avoid using nested tables, merged or split cells, or blank 
cells for formatting. 

 Ensure each slide has a unique title - Slide titles are used for navigation 
and selection by people who are not able to view the slide.  

 Check slide reading order - People who cannot view the slide will hear 
slide text, shapes and content read in a specific order. Items in the 
selection pane read from the bottom up. 

 Name your hyperlinks appropriately.  

 Include captions and audio descriptions - If you use audio or video 
components, ensure that all audio is captioned and any visuals are 
audio-described.  

 Use color carefully - High contrast color schemes and texture variations 
in graphs improve readability. Test your designs by printing in black & 
white.  
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 Fill in document properties - In advanced document properties, enter 
title, subject, and author. 

 Use content placeholders, not text boxes - To check if you have done 
this correctly, open View – Outline View. All text (except tables and alt 
text) should display in this pane. This ensures all readers have access 
to the text in your slides.  

 Notes may not be read - Some users of assistive technology cannot 
easily access your notes from your presentation. Consider adding them 
into a slide or sharing them in another format.  

 Sharing accessible presentations - When sharing electronically with 
your audience or on the web, consider converting to an accessible 
PDF. 

Best Practice Instructions 
This section will provide strategies for the following: 

1. Slide layouts 

2. Reading order 

3. Images and alternative text 

4. Table header row 

Slide Layout 

Tip #1: Use the built-in slide layouts 

Microsoft’s built-in slide layouts provide a correct reading order that screen 
reading software can detect. Use layouts instead of drawing text boxes 
manually – the contents of text boxes will be ignored by software such as 
screen readers. 

Choose a slide layout from Home > New Slide, or Home > Layout.  
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Select the layout that fits best with your content: 

 

Tip #2: Use the fields provided 

 Use only the fields included in the slide layout. 

 Avoid drawing your own text boxes to add more content. Only add 
content via a placeholder (placeholders are the boxes with dotted 
borders that reside in a slide layout and hold space for specific content). 

 It is OK to leave fields unused, except for the title field. 

Tip #3: Use a unique title for each slide 

Each slide should have a title, and it should be unique and descriptive so that 
you can get the gist of the presentation from the outline view. 

 Use the Click to add title field on every slide. 

 Other fields can be left empty, but not the title field. 

 Even if the entire slide is covered by an image, have a title behind it. 



 

19 

 

Alternative Text: Office 2013-2016 
Note: Sometimes images that are downloaded from the web have “junk” 
alternate text (usually a long file name). Make sure to manually check every 
image. 

Right-click on the image, then select Format Picture from the menu. (This 
menu option may be Format Shape on other types of graphics). 
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A Format Picture menu will open in the document pane to the right. Select 
the Layout and Properties tab, the third option in the Format Picture Pane. 

 

If it is not expanded already, open the Alt Text menu by clicking on the arrow. 

Type the alt text in the Description box. Ignore the Title field since it will not 
be read by a screen reader. 
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Alternative Text: Office 2010 & Earlier 
Right-click on the image to get the "Format Picture" menu option. 

 
Click on the "Alt Text" menu on the bottom left. 

The text goes in the "Description" section on the right (not the "Title" section). 
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Descriptive Links 
Links in a PowerPoint should be descriptive. Stay away from naming 
hyperlinks as “click here” or “here” as these do not allow a screen reader to let 
the user know what the link is.  

To make a hyperlink descriptive use the following: 

To format links in Microsoft Office, Select the link text. On the Insert Ribbon, 
click Hyperlink. 

 

Type the text that will be displayed in your document in the Text to Display 
field. 

 This should be a description followed by the link in 
parentheses: Description (Link) 

 For example: Accessibility By Design Website 
(http:/accessibility.colostate.edu) 

 This formatting allows for links to be readable in both electronic and 
paper copy 

Type the actual link in the Address field. This is the link that will be followed. 

 

https://accessibility.colostate.edu/
https://accessibility.colostate.edu/


 

23 

Table Header Row 
It is important to mark header rows in your table; otherwise, readers using 
assistive technology may not be able to read items within a table in the correct 
order. To set the header row on a table in PowerPoint, first Select the entire 
table. 

Select the Design tab in the ribbon under Table Tools. 

Check the checkbox titled Header Row at the top left of the Design ribbon. 

 

Color Contrast 
It’s best practice to use a solid background when creating slides so text placed 
on slides are easy to read and not difficult to cognitively process. It is 
recommended that you use the free Colour Contrast Analyser 
(https://developer.paciellogroup.com/resources/contrastanalyser/) to 
determine whether the contrast ratio passes WCAG AA standards. 

Installing the Colour Contrast Analyser (CCA) 

On the download page under Assets: 

 For Mac, download the CCA-3.0.1.dmg file 

 For Windows, download the CCA-Setup-3.0.1.exe file 

 

https://developer.paciellogroup.com/resources/contrastanalyser/
https://developer.paciellogroup.com/resources/contrastanalyser/
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Using the CCA 

Use the eyedropper tool to select foreground and background colors. The 
results display immediately, showing either pass or fail for both AA and AAA 
(WCAG 2) standards. In the following example, we have run the CCA on a 
website designed with orange headings, gray text, and blue link text. 

 

There is insufficient contrast between orange text and the white background. 
To find a different color with sufficient contrast, you can use the drop-down 
menu or insert hex codes. You would want to select a darker orange color 
from the drop-down color palette. 

 

AA vs AAA 

When we check the gray text against the white background, the CCA shows 
mixed results. This color combination passes at the "AA" standard, but not the 
more stringent "AAA" standard, which is the goal for most university and public 
websites. A darker gray would be better. 
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Finally, we test the blue link text against the white background. This 
combination of colors fails both the “AA” and “AAA” standards for normal text 
sizes, as well as the “AAA” test for larger sizes. It passes only the “AA” 
standard for large text. A darker blue is required for universal readability. 

 

Reading Order 
Reading order is important to consider for content that isn't linear. It applies to 
the more heavily visual layouts such as websites and PowerPoint 
presentations, as well as to PDF documents with columns, images, or forms. 
Setting the reading order allows text-to-speech or screen reading software to 
read the information in a logical order. It also ensures that links and form fields 
can be tabbed through sequentially for users who navigate with a keyboard or 
screen reader. 

How to set the reading order: 

On the Home Ribbon, select the Arrange drop-down menu. 
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Click on Selection Pane at the bottom of the Arrange menu. 

 

The Selection Pane will appear on the right side of the document. This lists 
each element on the slide and the order in which it will be read. 

Important! The reading order starts at the bottom and moves upwards. 

Click on an element in the Selection Pane to see the corresponding element 
highlighted in the slide. 

In the following screenshot, the Title will not be read first since it is not at the 
bottom of the list. Content Placeholder 2 will be read first. 
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To fix the reading order, Select Title 1 and Click the down arrow at the top 
right corner of the Selection pane to move it down to the bottom of the list. 

Click on each item, going from bottom to top, and adjust the order as 
necessary. This process needs to be done on every slide. 

Tip: Newer documents using slide layouts will be much less work than older 
documents that have been reused and updated year after year. To save time 
on fixing the reading order, transfer your content to a new document made 
with a version 2013 or newer template and slide layouts. 

Following these steps will help ensure your document is accessible. In 
addition, Microsoft Office has a built-in tool that generates a report on the 
accessibility of a document. The tool is available in both Word and 
PowerPoint. For more information on the Accessibility Checker tool, please 
visit the page Information on PowerPoint Accessibility Checker 
(https://accessibility.colostate.edu/ud-powerpoint/#1497913626925-fc217696-
e485) on the Colorado State University website. 

PowerPoint Accessibility Checklist 
� has unique slide titles 

� uses built-in slide layouts  

� has links that are descriptive  

� uses designated header rows for tables  

� uses solid backgrounds and contrasting color 

� provides alternative tests for images, charts, graphs 

� has an accurate reading order for all slides 

 

https://accessibility.colostate.edu/ud-powerpoint/#1497913626925-fc217696-e485
https://accessibility.colostate.edu/ud-powerpoint/#1497913626925-fc217696-e485
https://accessibility.colostate.edu/ud-powerpoint/#1497913626925-fc217696-e485
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Making PDF Documents 
Compliant 
Best Practices Overview 

 Use the Accessibility Checker - This built-in tool will tell you about 
possible issues in your document and give suggestions on how to 
correct them.  

 Convert scanned text - Make sure the document contains real text 
(scanned documents often render text as unreadable). If it does not, 
recreate the PDF file using the source document or convert it to include 
true text.  

 Set the document language - Setting the document language in a PDF 
enables some screen readers to switch to the appropriate language.  

 Check alternative text for all non-text elements.  

 Use color carefully - Make sure to use good color contrast, such as 
4.5:1 ratio of text to background, to ensure readability. It’s always best 
to start with an accessible source document (e.g., Word), then save it 
as a PDF.  

 Check for tags - Tags enable assistive technologies to read and interact 
with PDF documents. Headings (H1), paragraphs (P), and figures are 
examples of tag types. Check the tags pane to ensure there are tags, 
and if not, add them.  

 Check the reading order - Review the order of the tags in the Tags 
Pane to ensure the correct reading order.  

 Check for proper tag use - Use the Tags pane to check whether tagged 
elements are properly sequenced and applied. For example, is a first-
level heading tagged as an H1 and not an H3? Are lists, tables and 
images tagged appropriately? Do the tags match the text? Rearrange 
or rename tags as needed.  

 Artifacts - Artifacts are elements that are ignored by a screen reader, 
such as a background texture that does not contain important text. You 
can change an element to or from an artifact using the tag tree menu or 
the Touch Up Reading Order (TURO) tool.  

 Check form fields and buttons - If the PDF is intended to be an 
interactive document, add meaningful labels to the fillable form fields 
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and buttons. Set the tab order for the form fields, provide instructions, 
ensure proper keyboard focus, and ensure any error handling is 
accessible. 

Best Practices Instruction 
When you first scan a printed page to PDF, it creates a document that 
contains no actual text, just an image of text. Lacking any recognizable text, it 
does not allow interaction with reading tools, and is also difficult to read on a 
mobile device. 

In a few short steps, software such as Adobe Acrobat Professional, ABBYY 
FineReader, or OmniPage can take an image-only PDF and make it 
"Searchable" using a process called Text Recognition, or Optical Character 
Recognition (OCR). The resulting document has text that you can interact with 
using a variety of technologies. 

Benefits of a searchable PDF include the ability to: 

 Search text 

 Select text 

 Highlight text 

 Create a Table of Contents 

 Listen to text 

This section will focus on two types of inclusive PDF creation: 

1. Electronic conversion 

2. Creating fillable forms 

1. Electronic Conversion 
PDFs can be created from various software, but the resulting PDF may not 
automatically be accessible. Start with an accessible document, and configure 
the export options to include accessibility information. When exported 
correctly, components such as headings and alternate text will carry over to 
the PDF. For more details on electronic conversion, visit the page Converting 
documents to PDFs (https://accessibility.colostate.edu/ud-pdf/) on the 
Colorado State University website. 

https://accessibility.colostate.edu/ud-pdf/
https://accessibility.colostate.edu/ud-pdf/
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Tags 

Reading order is important to consider for content that isn't linear. It applies to 
the more heavily visual layouts such as websites and PowerPoint 
presentations, as well as to PDF documents with columns, images, or forms. 
Setting the reading order allows text-to-speech or screen reading software to 
read the information in a logical order. It also ensures that links and form fields 
can be tabbed through sequentially for users who navigate with a keyboard or 
screen reader. 

Tags are how Adobe designates document structure in a PDF. They indicate 
reading order as well as headings and alternative text for images.  

If you converted an accessible Word document or PowerPoint to PDF, you’ll 
be starting with a well-tagged PDF file; in most cases, PDF files created using 
this method are 90% accessible. To be fully accessible, all page content must 
be tagged, and the tags must correspond with the reading order. 

To view the tags in Acrobat DC, open the Tags panel. From here you can 
edit a tag title, change a tag location, or change a tag type if needed. 
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To view tags in Acrobat XI, open the Accessibility Toolbar, and click Add Tags 
to Document. 

 

To check the accuracy of autotags, switch to the Order Panel to see if the 
document has been tagged correctly. The numbers in the panel correspond to 
the numbers highlighted on the page. 
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Reading Order 

On the Accessibility Toolbar, select Reading Order (Acrobat DC) or TouchUp 
Reading Order (Acrobat XI). 

 

Your page should now have some numbers on it. These are the 'Tags' that 
determine the reading order.  

 

If the order is incorrect, it’s best to go back into the Tags panel to adjust it. 
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You can drag the tagged elements into the correct order.  

 

Images and Alt Text 

Images convey information quickly and powerfully—assuming they can be 
seen and understood. However, some readers may not understand the 
meaning of the image; others may not be able to see it due to visual 
impairment, personal viewing preferences (especially on the web), or 
technological limitations. 
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Alternate text (“alt text” or "alt tag") is added to an image to provide a textual 
alternative to visual information. Why is this important? Remember, some 
users will not see your information; instead, they’ll hear it using text-to-speech 
or screen-reading software. By adding alt text to an image, you make its 
meaning available to people who, for whatever reason, cannot see it. 

Alternate text should be added to all non-text elements, including: 

 Pictures 

 Graphs 

 Charts 

 Tables 

 Microsoft Office SmartArt 

Make alternate text meaningful to a listener: 

1. What is the context of the image? What meaning does it add to the 
page? 

2. Be concise. Describe only what you expect visual users to get out of the 
image. 

3. If the image is already described in the surrounding text, the alt text can 
be very short. 

4. Avoid redundant statements like “Image of” or “This is a picture of.” 
Simply state what it is. 

5. If an image is purely decorative, mark it as such (various methods 
depending on software; Office 365 provides a “Mark as Decorative” 
option, but older versions of Word do not). 

Use the Action Wizard in Acrobat to detect any images (Figures) in a PDF. 
(See instructions on using the Accessibility Checker in Acrobat 
(https://accessibility.colostate.edu/ud-pdf/#1503006362254-ea4e9739-5014).) 

 

https://accessibility.colostate.edu/ud-pdf/#1503006362254-ea4e9739-5014
https://accessibility.colostate.edu/ud-pdf/#1503006362254-ea4e9739-5014
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The Wizard will prompt you to add alternate text to any images it finds. 

 

Following these steps will help ensure your document is accessible. In 
addition, Microsoft Office has a built-in tool that generates a report on the 
accessibility of a document. The tool is available in both Word and 
PowerPoint. For more information on the Accessibility checker please visit the 
page Information on PDF Accessibility Checker 
(https://accessibility.colostate.edu/ud-pdf/#1499879148274-46cc3507-67e2) 
on the Colorado State University website. 

2. Fillable Forms 
For a form to be accessible, it should be usable by people who use a screen 
reader or a keyboard to navigate. 

1. A user should be able to complete a form using only a keyboard, 
including interacting with dialog boxes. 

2. Form fields should be labeled descriptively. 

3. Tab order should be logical. 

To edit a form in Acrobat, open the form editor tool. In Acrobat DC go to Tools 
> Prepare Form. In earlier versions of Acrobat, go to Tools > Forms > Edit. 
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Once the form field editor is open, existing form fields will be highlighted within 
the document. The form field labels will appear inside fields. Check these 
labels to make sure they are descriptive. In the example below, you can see 
that the Student Name field matches the label: 

 

If the label does not match, double-click on the label to edit it. In the Text Field 
Properties dialog box that appears, edit the Name field: 
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Once your labels are correct, check the tab order. Keyboard and screen 
reader users will use the Tab key to jump from one field to the next, and this 
needs to happen in a logical order. To see the tab order, click on the drop-
down menu icon next to "Fields" in the Form toolbar (Acrobat DC). 
Select Show Tab Numbers. 

 

Now you should see numbers inside of each form field that tell you the tab 
order. In the following screen shot, the logical order for the checkboxes is mp3 
(6), PDF (7), then Daisy (8). With the current incorrect tab order, it will be read 
as mp3, Daisy, then PDF. 
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To fix the tab order, select the PDF label on the form. This will also select the 
correct label in the toolbar on the right. In the toolbar, select and drag "PDF" 
upwards into the correct position between mp3 and Daisy. 

 

PDF Accessibility Checklist 
� has clear, legible copy 

� has readable text (if a converted document) 

� has sufficient color contrast 

� has accurate tags 

� has an accurate reading order 

� includes alt text for images, charts, graphs 
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Resources for Outsourcing  
508 Compliance 
There are a number of vendors in this space and more are emerging all of the time 
due to the need for making products 508 compliant.  Here are just a few (not at all a 
comprehensive list) that have been used to produce favorable results. Who you 
choose to use may vary based on cost, length of time to produce documents, ability to 
access services, and methods of payment. Your agency might require a vetting 
process in order to select a vendor. Pricing will certainly vary based on the number 
and complexity of documents. 

Captioning 
Closed captioning services providers give visual aid to videos in the form of subtitles, 
integrating transcribed text from dialogue and sounds as they happen. Closed 
captioning, originally designed to help individuals with hearing challenges understand 
spoken words and music on television shows and movies, is now also used in different 
situations where it would benefit audiences that are not necessarily hearing impaired 
to understand dialogue clarification and contextual details. Here are two websites 
containing lists of vendors that can provide these services: 

 Live (Open) Captioning Service Vendors (https://dcmp.org/learn/10-captioning-
service-vendors)  

 Closed Captioning Service Vendors (https://www.g2.com/categories/closed-
captioning-services)   

Document remediation 
In the event you wish to use an outside service for making Word, PDFs, PowerPoints, 
and Excel documents 508 compliant, here are a few vendors to consider.  
 Open Access Technologies (https://www.openaccesstech.com/) 
 AccessibilityOz (https://www.accessibilityoz.com/) 
 CommonLook (https://commonlook.com/) 
 Braille Works (https://brailleworks.com/) 
 SensusAccess (https://www.sensusaccess.com/) 
 Equidox (https://equidox.co/) 
 Appligent (https://appligent.com/) 
 Abledocs (https://abledocs.com/) 

https://dcmp.org/learn/10-captioning-service-vendors
https://dcmp.org/learn/10-captioning-service-vendors
https://www.g2.com/categories/closed-captioning-services
https://www.g2.com/categories/closed-captioning-services
https://www.g2.com/categories/closed-captioning-services%C2%A0
https://www.openaccesstech.com/
https://www.accessibilityoz.com/
https://commonlook.com/
https://brailleworks.com/
https://www.sensusaccess.com/
https://equidox.co/
https://appligent.com/
https://abledocs.com/
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About TBI TARC  
The Traumatic Brain Injury Technical Assistance and Resources Center (TBI TARC) is an 
initiative from the Administration for Community Living that helps TBI State Partnership 
Program grantees promote access to integrated, coordinated services and supports for 
people who have sustained a TBI, their families, and their caregivers. The Center also 
provides a variety of resources to non-grantee states, people affected by brain injury, 
policymakers, and providers. 
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